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1. Introduction 
 

This is a step-by-step guide to exoplanet observing that is intended for both the newcomer to 

exoplanet observing, as well as for the more-experienced exoplanet observer. For the former, it is 

desirable that the user have some experience in deep sky or variable star imaging. The more 

experienced exoplanet observer may find this Guide useful as a refresher on “best practices,” as 

well as a practical guide for using AstroImageJ (AIJ) for image processing and exoplanet transit 

modeling. AIJ is freeware software that is an all-in-one package for image calibration, 

differential photometry, and exoplanet modeling. AIJ is quickly becoming the de facto standard 

for exoplanet analysis and modeling by advanced amateur astronomers, as well as by some 

professional astronomers. 

This Guide will lead the user through all the phases of exoplanet observing, from the selection of 

suitable exoplanet targets to modeling of exoplanet transits. Actual exoplanet transits are used to 

demonstrate the techniques and AIJ capabilities for exoplanet transit modeling. 

Links to the latest version of this Guide and accompanying material can be found at 

http://astrodennis.com. 

In various sections below, references are made to a separate AIJ User Guide that was authored 

by the developer of AIJ and describes more details and options on the use of AIJ than are 

covered in this guide. The latest version of the AIJ User Guide, and a link to the AIJ user forum, 

can be found at AIJ’s website: http://www.astro.louisville.edu/software/astroimagej/. An in-

depth description of AIJ features can be found in the following paper: 

http://arxiv.org/abs/1601.02622. 

 

2. Background 

 
In 1995, 51 Pegasi b was the first exoplanet detected around a main sequence star. To date, over 

3,500 exoplanets have been confirmed by Kepler and other space and ground-based 

observatories.   

Amateur astronomers have been successfully detecting exoplanets for at least a decade, and have 

been doing so with amazing accuracy! Furthermore, they have been able to make such 

observations with the same equipment that they use to create fabulous looking deep sky pictures 

or variable star light curves. 

Several examples exist of amateur astronomers providing valuable data in support of exoplanet 

research. In 2004, a team of professional/amateur astronomers collaborated on the XO Project, 

which resulted in the discovery of several exoplanets. The KELT (Kilodegree Extremely Little 

Telescope) (Pepper et al., 2007) program uses a world-wide network of amateur astronomers and 

small colleges, along with professional astronomers, to conduct follow-up observations of 

http://astrodennis.com/
http://www.astro.louisville.edu/software/astroimagej/
http://arxiv.org/abs/1601.02622
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candidate exoplanets transiting bright stars. A network of amateur astronomers recently 

supported a Hubble survey of some 15 exoplanets by conducting observations in the optical 

wavelength, while Hubble was studying these same exoplanets in the near-infrared (Conti, 2015 

and Motta, 2017).  Amateur astronomer observations such as these help to confirm candidate 

exoplanets, as well as refine the ephemeris of already known exoplanets. The mere fact that 

amateur astronomers can accurately model the transits of existing exoplanets means that it is also 

theoretically possible for them to discover new exoplanets! For example, by detecting variations 

in the transit time of a known exoplanet (a technique called “transit time variations”, or TTV), 

amateur astronomers can detect the existence of another planet orbiting the host star. 

The formalization of “best practice” techniques for exoplanet detection by amateur astronomers 

began in 2007 with Bruce Gary’s publication of “Exoplanet Observing for Amateurs.” At the 

same time, Gary began an effort to archive the exoplanet observations of other amateur 

astronomers. This archive, the Amateur Exoplanet Archive (AXA), was subsequently transferred 

to the now more active Exoplanet Transit Database (ETD) project, an online archive sponsored 

by the Czech Astronomical Society (http://var2.astro.cz/ETD/contribution.php). 

As new space telescopes such as TESS (Transiting Exoplanet Survey Satellite) (Ricker et al., 

2015) and JWST (James Webb Space Telescope) (NASA, 2017) come online in the next 2-3 

years, the need for amateur astronomer participation in exoplanet research is only going to 

increase. In particular, followup observations of candidate exoplanets will be needed to help 

determine whether an observed transit is a false positive - for example, whether the transit is 

actually due to an exoplanet or to an eclipsing binary. 

In order to contribute to exoplanet science, observations by amateur astronomers demand a much 

more rigorous approach than that required for more typical amateur astronomer endeavors, such 

as deep sky or planetary imaging. This Guide describes the best practices that have evolved to 

date for conducting such research-grade exoplanet observing. 

Section 3 will provide an overview of exoplanet observing. Section 4 will discuss some of the 

considerations involved in the selection of equipment for exoplanet observing.  Section 5 will 

review the preliminary steps to be taken prior the observation itself. Section 6 will then review 

the best practices involved in an exoplanet observation. Finally, Section 7 will present a detailed 

description of the use of AIJ in exoplanet image reduction and transit modeling. 

 

3. Exoplanet Observing 

 
The basic concept of exoplanet observing involves taking a series of images of the field 

surrounding the host star of an exoplanet before, during, and after the predicted times of the 

exoplanet transit across the face of its host star. 

Because the transit method is the dominant technique used by amateur astronomers to conduct 

exoplanet observations, this Guide will focus on observing and modeling techniques related to 

this method. The transit method is useful for detecting a “hot Jupiter,” namely a large planet 

http://var2.astro.cz/ETD/contribution.php
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whose orbit is close to its host star and where the planet passes directly in front of the star from 

the perspective of an observer on Earth. The transit method relies on measuring the flux of the 

suspected host star (herein also referred to as “the target star”), as well as the flux of multiple 

“comparison stars” that are all in the same field-of-view. 

Exoplanet transits are typically 2-4 hours long. However, conducting an exoplanet observation 

also involves beginning the imaging session at least 30 minutes prior to the predicted beginning 

of transit (“pre-ingress”) and continuing for at least 30 minutes after the expected transit (“post-

egress”). These “pre-ingress” and “post-egress” times are used to help establish an out-of-transit 

(OOT) baseline.  Thus, it is not unusual for an exoplanet observing session to be 6 hours in 

length. 

A technique called differential photometry is used to determine the changes in brightness (flux) 

of the exoplanet’s host star that might indicate an exoplanet transit. This technique compares the 

relative difference between the host star and one or more (assumed to be non-variable) 

comparison or “comp” stars during the imaging session. Since the difference in brightness of the 

host star and comp star(s) are equally influenced by common factors such as thin overhead 

clouds, moon glow, light pollution, etc., a change in this difference would be a measure of the 

effects of the drop in brightness of the host star due to an exoplanet transiting in front of it. 

The data points that represent the star’s relative change in brightness are then used to model the 

exoplanet transit. A “best fit” transit model is then created from these data points. This best fit 

results in estimates of key parameters about the exoplanet and its transit. These parameters 

include: 

1. the square of the ratio of the radius of the exoplanet (Rp) to that of its host star (R*),  

2. the ratio of the exoplanet’s semi-major orbital radius (a) to R*, 

3. the center point Tc and the duration of the transit, 

4. the inclination of the exoplanet’s orbit relative to the observer’s line-of-sight. 

Thus, by knowing the radius R* of the exoplanet’s host star, the exoplanet observer can then 

actually estimate the radius of the exoplanet, as well as the radius of its semi-major orbit. 

 

4. Instrumentation 

 
Certainly cost is a factor when selecting the complement of equipment to be used in exoplanet 

observing. And as expected, higher precision demands higher cost equipment. Thus, the choice 

of equipment (and therefore precision associated with that equipment) is determined mostly by 

economics. However, amateur astronomers with modest equipment on the order of what is 

typically used for deep sky imaging have materially contributed to exoplanet science. 

As will be seen, a recurring theme throughout this Guide is the desire to minimize the movement 

of the star field across the CCD detector during a multi-hour observing session. 
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The following describes those equipment characteristics that most affect exoplanet observing 

precision and help reduce the effects of systematics. 

 

4.1. Mount 

 

The three most popular mount types are German equatorial mounts (GEMs), fork mounts, and 

alt-az (altitude-azimuth) mounts. Of the three, the alt-az mount is the least desirable for 

exoplanet observing due to the continuous corrections that need to be made in three (3) axes to 

keep a star in relatively the same position throughout the observing session. These corrections 

need to be made in elevation, azimuth, and position angle. Obviously, this means that the 

precision associated with any of these three axis corrections will affect the observer’s overall 

ability to minimize star movement. Position angle corrections, for example, are normally made 

by a rotator, and the incremental step size of the rotator, as well as the cadence of such 

corrections, will affect the precision with which the image chain can rotate to relatively the same 

pixel position throughout the observing session. 

GEMs, which are popular cost-effective mounts for deep-sky and planetary imaging. However, 

GEMs will typically require a meridian flip when the target star passes across the meridian. 

Although some GEMs can continue tracking for some amount of time after the meridian, 

observations that require longer tracking will ultimately require a meridian flip. A meridian flip 

results in two factors affecting precision: (1) valuable data points are lost during the time it takes 

for the meridian flip, and (2) with no rotation of the imaging chain, the target and comparison 

stars will fall on the part of the imaging camera’s detector that is diagonally opposite to where 

they were pre-flip. The implication of the latter is that the flux of stars would artificially increase 

or decrease due to them landing on part of a dust donut that was not fully corrected by flat 

fielding. Even if the image chain was rotated, getting the target and comparison stars on nearly 

the same pixel locations as pre-flip would be practically impossible. It should be noted that 

software such as AIJ can help compensate for the effects of a meridian flip, especially if it occurs 

near mid-transit. 

Although fork mounts thus are the most suitable mount for exoplanet observing because of their 

ability to continuously track a target star for a long duration without having to be interrupted to 

perform a meridian flip, GEMs have been used by amateur and professional astronomers alike to 

do high precision exoplanet observing. 

Regardless of the type of mount used, tracking precision is also a function of any periodic error 

in the mount’s gears. Periodic Error Correction (PEC) and autoguiding will help mitigate such 

periodic errors. It should be noted that some of today’s mounts can operate for minutes with 

minimal errors; this of course comes at greater expense. 

Best practices associated with the operation of the mount itself include: 

1. polar align the mount as accurately as possible (e.g., within a few arcseconds of the 

celestial pole); 

2. balance the mount to help reduce RA errors; 



8 

 

3. in the case of a GEM mount, reduce RA backlash by always keeping the mount “East 

heavy” – this will help with any plate solving that might be needed after a meridian flip 

in order to get back on target; 

4. minimize DEC backlash, which would allow for better DEC corrections during 

autoguiding; 

5. minimize periodic error by checking for any worm or ring gear grit, as well as by using 

PEC to help correct any remaining errors. 

 

4.2. Optical Tube Assembly (OTA) 

 

Best practices associated with choosing and maintaining the telescope’s optical tube assembly 

(OTA) include the following: 

1. Aperture matters, so the larger the aperture, the greater ability to collect photons in a 

given unit of time. This is especially important for fainter target stars. 

2. The OTA should be in situ for enough time for it to get acclimated to the temperature of 

its operating environment. This would help reduce any internal air turbulence due to 

changing temperature within the OTA. 

3. In order to produce a well-formed point spread function (PSF) for the target and each 

comparison star, the OTA should be well-collimated. 

4. For Schmidt-Cassegrain OTAs, the primary mirror should be locked down, if possible, in 

order to reduce the effects of “mirror flop.” 

 

4.3. Imaging Camera 

 

A variety of cameras have been used for exoplanet transit observing. These include stand-alone 

CCD and CMOS cameras similar to those used for deep sky imaging, as well as DSLR’s. 

However, for conducting research-grade exoplanet observing, the camera should be 

monochrome. This is so that it would be possible to use different standard photometric filters.  

Because DSLR cameras are inherently color and therefore don’t lend themselves to the use of 

filters, they are the least desirable imaging camera choice.  

Best practices for choosing an imaging camera to use in exoplanet observing is dependent upon 

factors such as: 

1. The expected seeing conditions at the observer’s location. This is defined as the typical 

full-width-at-half-maximum (FWHM)  of stars measured at the observer’s location and 

expressed in arcseconds. 

2. The size (i.e., format) of the camera’s detector.  Although a larger format allows for a 

greater variety of comparison stars to choose from, small format detectors have 

successfully been used in research-grade exoplanet observing. 

3. The bias, dark current and readout noise of the camera.  These factors, however, are 

much reduced in today’s newer cameras. 
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In general, most modern monochrome imaging cameras that the observer has or will be acquiring 

for other applications such as deep sky imaging, should be satisfactory for exoplanet observing. 

 

4.4. Autoguiding 

 

Autoguiding is essential for research-grade exoplanet observing in order to minimize the drift of 

the target and comparison stars. Drift due to polar misalignment, for example, will cause field 

rotation of stars and therefore their movement over the field-of-view. This movement over a not 

fully flat-field corrected image can seriously affect the precision of the observation. 

The most common approaches to autoguiding and their pros and cons are: 

1. Use of a separate guide scope – this is the least desirable method due to issues with 

flexure that may occur during the observing session. 

 

2. Off-axis guiding – although frequently used by deep sky imagers to get pinpoint stars, 

this technique will still result in some amount of field rotation of the target and 

comparison stars in the presence of even a small amount of polar misalignment. This is 

true even with sub-arcsecond movement of the guide star itself. The amount of field 

rotation (i.e., the drift in RA and DEC) will be a function of:  

a. the distance of the guide star from the target or comp stars in question; 

b. the amount of polar misalignment; 

c. the amount of delta movement of the guide star itself; 

d. the declination angle when the image is taken (polar misalignment will have a 

greater affect, especially in RA, when imaging at higher declinations). 

 

3. On-axis guiding – this technique employs a dichroic beam splitter to separate the light 

path of the main image into a near infrared (NIR) path and a visible light path (di Cicco, 

2012) . Here, the guide camera sees, via the infrared path, part of the same image as the 

imaging camera (depending on the size of the guide camera’s detector). With this 

technique, the guide star is closer to the target and comparison stars, and therefore the 

effects of any polar misalignment are reduced as compared to the off-axis guiding 

approach. Furthermore, in the case of meridian flips with GEMs, the same guide star that 

was being used pre-flip can also be used post-flip, thereby eliminating the need for a 

rotator or for a search for another guide star, if no imaging chain rotation takes place. 

 

4. Image guiding – a relatively new autoguiding technique is to make mount corrections 

between exposures based on the amount of total shift of the science image itself. (Note: 

the term science image is used in this Guide to refer to the raw images of the field-of-

view containing the exoplanet host star; such images are also often referred to as Lights 

by other image processing software.) A variant of this is being developed (Baudat, 2017), 

whereby mount corrections will be made during exposures of the science images. 
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In addition to the above autoguiding techniques, active optics (AO) devices are also available to 

the amateur astronomer so that a variety of rapid gear errors can be corrected without making 

physical “bumps” to the mount. This technique uses a “tip-tilt” mirror or a straight-through 

optical window that is in the optical path to keep a guide star centered without making physical 

“bumps” to the mount. 

Autoguiding software is optionally available for most of the popular imaging software packages. 

A popular freeware guiding software package is PHD2 (see http://openphdguiding.org). 

 

4.5. Filters 

 

As mentioned earlier, it is desirable that a standard photometric filter be used for exoplanet work,  

such as the Johnson-Cousins U,V, B, Rc, and Ic filters, or the SDSS (Sloan Digital Sky Survey) 

u’, g’, r’, and i’ filters. This is true for at least three reasons: 

1. limb darkening coefficients used during the transit modeling process are a function of the 

(standard) filter type, as well as stellar parameters of the target star; 

2. distinguishing transits due to eclipsing binaries vs. exoplanets employs using alternating 

standard filters across the observing session - the transit depth of the eclipsing binary will 

generally be different for two different filters; 

3. results from two different observers can be better compared. 

Even though it is not a “standard” photometric filter, a Clear Blue Blocking (CBB) filter, 

sometimes called an “Exoplanet Filter,” can be used to reduce the effects of sky glow. 

 

5. Preliminaries 

 
This section discusses some of the preliminary steps which can be done several days prior to the 

actual exoplanet observation that will lead to a more effective observing session. 

 

5.1. Information Collection 

 

Appendix A is an example of an Excel worksheet that the observer can use to record certain 

pieces of critical information about the observation, and will also provide a convenient source of 

information needed by AIJ.  The data depicted in Appendix A is also used as the basis for the 

example in this Guide, namely the modeling of a full transit of the WASP-12b exoplanet.  If no 

changes are made to the observer’s instruments or location, items 12-23 in Appendix A can be 

used across multiple observing sessions 

The latest version of this worksheet can be downloaded from http://www.astrodennis.com. The 

spreadsheet also contains hot links to web resources where the user can obtain some of the 

information, if available, on the target star and exoplanet parameters that are needed as input to 

the transit modeling phase, including the appropriate limb darkening coefficients for the 

http://openphdguiding.org/
http://www.astrodennis.com/
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particular filter being used in the observation.  

 

5.2. Considerations for Selecting an Exoplanet Target 

 

The following are useful sources for predicting exoplanet transits for a given time period at a 

particular observer’s location: 

NASA Exoplanet Archive: http://exoplanetarchive.ipac.caltech.edu/cgi-

bin/TransitView/nph-visibletbls?dataset=transits 

Exoplanet Transit Database (ETD) Website: http://var2.astro.cz/ETD/predictions.php. 

If the exoplanet observer is selecting his/her own exoplanet target (i.e., one not specified as part 

of a particular research campaign), then the following selection criteria should be considered that 

will result in a more satisfying result: 

1. Beginning time of transit – since it is desirable that the imaging session start at least 30 

minutes before the beginning of the transit, this may negate some exoplanet candidates 

since this might put the start time before or even during twilight. 

2. Duration of transit – with some transit durations longer than others, the observer may 

want to pick a candidate whose total session time (considering the desire to image 30 

minutes after the actual end of the transit) is suitable to the observer. 

3. Magnitude of the host star and depth of the transit – exoplanet host stars can range in V 

magnitude from 8.0 to over 13.0, and dips in the star’s magnitude due to the exoplanet 

transit can range from hundredths to thousandths of a magnitude. The observer might 

therefore want to choose an exoplanet target with a larger predicted % drop in magnitude 

than another potential target. 

 

Exoplanet transit depths are often expressed in milli-magnitudes (mmag), where 1 mmag = 0.001 

magnitude. Thus, a transit depth of 10 mmag equals a drop in magnitude of 0.01 or 1%. Transit 

depths less than 10 mmag have been achievable using sub-meter aperture telescopes under 

suitable seeing conditions. Note that the relation between magnitude and flux is such that f1/f2 = 

2.512(m2-m1) , where f1 and f2 are fluxes and m1and m2 are the corresponding magnitudes. Thus, 

a  0.01 drop in magnitude equals a 0.009 relative change in flux. Because flux and magnitude at 

these small amounts are approximately the same, relative changes in flux are often used as a 

substitute for magnitude when measuring and referring to the transit depth. 

 

5.3. Meridian Flip Predictions 

 

For observers with German equatorial mounts, the observer should predict approximately when, 

if at all, a meridian flip might be required during the imaging session. This prediction is typically 

done using the observer’s navigation software and is helpful so that the observer can be available 

during the meridian flip to make any necessary adjustments for repositioning the imaging 

system’s field-of-view as expeditiously as possible. 

http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://exoplanetarchive.ipac.caltech.edu/cgi-bin/TransitView/nph-visibletbls?dataset=transits
http://var2.astro.cz/ETD/predictions.php
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Observers with German equatorial mounts may also face another issue associated with a 

meridian flip. Namely, if there is no rotation of the imaging chain, a new guide star will be 

needed to be acquired when off-axis guiding is employed.  Section 4.4 discussed the advantages 

of on-axis guiding for this situation. 

 

6. Best Practices 
 

This section describes the best practices associated with the actual exoplanet observation. These 

best practices should help the exoplanet observer obtain the highest level of precision for a given 

instrumentation package. They are organized by the respective phase of the exoplanet observing 

process to which they apply. 

 

6.1. Preparation Phase 

 

6.1.1. File Directories 

 

On the computer that runs the observer’s image capture software, it is best to initially setup the 

following subdirectories: AIJ Analysis, Bias, Darks, Flats, Quarantined Images, and Science 

Images. The AIJ Analysis subdirectory is where measurement and model fit files from AIJ can 

be stored.  The Bias, Darks, and Flats subdirectories are where he respective calibration files can 

be stored. The Science Images subdirectory would hold the raw images containing the target star, 

and the Quarantined Images subdirectory is where “bad” science images due to cosmic ray hits, 

satellite, tracks, etc. could be parked.  If the user wishes to use other names for these 

subdirectories, then such names may be substituted for their respective counterparts in the 

examples that follow. 

 

6.1.2. Stabilization of Imaging System to Appropriate Temperature 

 

The imaging system should be put in place with enough time for it to reach its desired 

temperature set-point, which might also require enabling of its cooling system. 

 

6.1.3. Generation of Flat Files 

 

Whether twilight flats are taken or flats are generated by using an electroluminescence panel, 

they should (ideally) be redone prior to or after each imaging session using the same imaging 

chain as was used for taking the science images, and with the imaging chain not having been 

displaced or moved. See Section 6.3.2 for guidelines on creating flats. 
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6.1.4. Autoguiding 

 

Autoguiding should be used during the Imaging Phase below, unless the observer’s mount is of 

such accuracy that it can maintain guiding within a few pixels for the duration of the transit 

observation (where the actual value of “a few” depends on the FWHM of the host star). See 

Section 4.4 above for an overview of various autoguiding techniques. The observer’s auto-

guiding mechanism should be calibrated, if not yet done or if the auto-guiding software does not 

automatically correct for changes in declination. If needed, calibration should also be done for 

any active optics (AO) system that is being used. 

 

6.2. Imaging Phase 

 

6.2.1. Choice of Binning 

 

The FWHM of stars in the target field should be spread out over 3-5 pixels. If the imaging 

camera is normally setup to bin more than 1x1, binning might have to be reduced to achieve this. 

This then would result in an acceptable image scale (sometimes called “plate scale” or “pixel 

scale”). Image scale is expressed in arc-seconds per pixel and is a function of the focal length of 

the telescope and the size of the CCD photosite. For example, assume that the FWHM is 3.0 arc-

seconds, and the unbinned image scale of the observer’s imaging system is 0.5 arc-seconds/pixel. 

This means that, without binning, the FWHM would be spread over 6 pixels and that 2x2 binning 

would mean that that the FWHM would be spread over 3 pixels, still within the acceptable, albeit 

the lower, part of the range. 

Stars should be brought into precise focus if for no other reason than to get an accurate measure 

of FWHM. However, if the target star is too bright and could saturate the imaging camera, it may 

be necessary to defocus the OTA. If the sky background is not too high, defocusing that results 

in a PSF of 10-20 pixels is acceptable, as long as this defocusing doesn’t result in the flux of a 

nearby star blending with the target star’s flux. 

 

6.2.2. Choice of Exposure Time 

 

The optimal exposure time is one that maximizes the target star’s SNR, while not saturating the 

imaging camera’s detector. For a given target star, factors that affect the optimal exposure time 

include: 

1. the telescope’s aperture size, 

2. the filter used, 

3. the quantum efficiency (QE) of the imaging camera, 

4. whether the star is rising to the local meridian, or has passed the meridian and is falling, 

and 

5. seeing conditions. 
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Today’s CCD detectors typically have a linear range up to a point, after which they become non-

linear and then, at some point they become saturated. At its saturation point,  any additional 

photons hitting the CCD photosite will not be registered. Thus, it is critical that the target and 

comp stars never reach saturation and ideally not reach non-linearity as well (it should be noted, 

however, that software such as AIJ does provide a facility for making non-linearity corrections). 

It is important that the exposure time be chosen such that a decent SNR is achieved, but not long 

enough that neither non-linearity nor saturation occurs.  If the target star is predicted to rise 

toward the local meridian and, therefore its light will pass through less and less air mass, either 

of these two situations could occur. Thus, the observer should also take this into consideration 

when choosing an exposure time. Note that defocusing could also help this situation. 

In order to initially set the correct exposure time, a series of test images should be taken with 

increasing exposure time. The SNR of the target star, as well as its ADU counts, could then be 

measured for each exposure setting. Section 7.5.1 describes how AIJ can be used to determine a 

star’s SNR.  An exposure setting that maximizes SNR, but doesn’t present a potential for 

saturation during the imaging session should then be considered as the ideal exposure time. 

The following best practice procedure conducted immediately prior to the actual observing 

session is recommended to determine the optimal exposure time: 

1. At the target star’s current sky position, take test images at various exposure times. First, 

select the exposure time with the greatest SNR for the target star where the peak ADU 

count is less than 75% of the saturation point of the imaging camera’s detector.  Note: 

this 75% limit may have to be reduced if the camera is expected to reach non-linearity 

much earlier. 

2. If the star will be rising toward the local meridian, reduce the exposure time such that the 

detector will not reach saturation. 

3. If the star will be falling from the local meridian, increase the exposure time such that the 

peak ADU count of the target star is equal to 75% of the saturation point of the detector.  

There are some situations where the professional science team might require a certain cadence of 

images to be taken, which might be at the expense of the (longer) optimal exposure time. This 

may be the case where finer details of the pattern of the light curve are more important than the 

accuracy of the light curve depth itself. 

 

6.2.3. Time Synchronization 

 

Because of the natural drift in the image capture computer’s clock, it should be frequently 

synchronized with the U.S. Naval Observatory’s Internet time server. This can be done using 

(freeware) software such as Dimension 4 (see http://www.thinkman.com/dimension4/).  The 

update period for such clock synchronizations should be set to at least every 2 hours. 

 

http://www.thinkman.com/dimension4/
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6.2.4. Time System 

 

Because of the existence of several different time systems, the exoplanet observer should be 

aware which one is being used for the transit prediction, which one is being entered into the 

image FITS headers, which one is being used during the light curve modeling process, etc. The 

more commonly used time systems are: 

a) Julian Date/Universal Coordinated Time (JDUTC), 

b) Heliocentric Julian Date/Universal Coordinated Time (HJDUTC), 

c) Barycentric Julian Date/Barycentric Dynamical Time (BJDTDB). 

If the results of the exoplanet observation are to be used in a professional/amateur collaboration, 

BJDTDB would be the desired time standard to use during the model fitting process. Sections 

7.2.2 and 7.6 describe how AIJ can convert the time of the captured images to BJDTDB time. 

 

6.2.5. Operating Temperature 

 

The imaging system should be put in its operating environment with enough time for it to reach 

as low a temperature set-point as possible, which might also require enabling of its cooling 

system. 

 

6.2.6. Image Capturing 

 

The observer’s normal image capture software is used to capture the science images into the 

Science Images subdirectory during this phase. Should a meridian flip be necessary during the 

imaging session, then at the time the meridian flip is needed, the observer should: 

1. Abort the image capture software 

2. Stop autoguiding 

3. Execute the meridian flip 

4. Reposition the target star as necessary in the camera’s field-of-view 

5. Enable autoguiding 

6. Enable the image capture software. 

 

6.3. Image Calibration Phase 

 

6.3.1. Calibration Files 

 

Prior to or after the capture of science images, the user would also capture a series of darks, flat 

field, and bias calibration files and store them in their respective subdirectories.  A rule of thumb 

is to (ideally) capture an odd number of images for each such calibration series. An odd number 

is suggested, since this better allows for a median combine to later be used to create the master 
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dark, master flat, and/or master bias files. In any case, at least sixteen (16) images should be 

captured for each calibration file type. 

Guidelines for exposure times for each of these calibration file types are as follows: 

1. Dark files – exposure time should equal that of the science images and should be taken at 

the same temperature as were the science images. 

2. Flat field files – exposure time is dependent on the flat fielding technique used, but 

typically takes 3 seconds or less.  However, this exposure time may have to be increased 

for cameras with automatic shutters so that no shutter shading occurs. A rule of thumb is 

to create flat field frames such that the resulting histogram is mid-way within the 

dynamic range of the CCD detector.  For example, for a detector with a typical maximum 

ADU count of 65,000, the brightness of the light source would be set such that the center 

of the resulting histogram is at 32,000 ADUs. As discussed in Section 6.3.2 below, 

special consideration is needed for the creation of flat files. 

3. Bias files – a bias file is a dark file of 0 second exposure time. 

Typically, flat dark files are also created since the flat fields themselves contain dark current that 

needs to be subtracted out. When used, “flat darks” are taken at the same exposure time as the 

flat field files themselves. However, as seen in Section 7.2 below, a technique employed by AIJ 

that can scale the Master Dark to the same exposure time as the Master Flat obviates the need for 

the user to generate flat dark files. 

 

6.3.2. Flat Fielding Techniques 

 

Because star movement over a few pixels is inevitable even with autoguiding and fairly accurate 

polar alignment, flat field correction is relied upon to mitigate the effects of dust donuts and 

vignetting. Poor flat fielding is one of the major contributors to systematics. For example, Figure 

1 depicts a flat field and the potential movement of a star onto a nearby dust donut. Figure 2 

depicts what would happen in the case of a meridian flip, namely the star would flip across the 

diagonal of the detector and possible land on another dust donut. If flat field correction is not 

performed for either of these two cases, the flux of the star in question would artificially change. 
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Figure 1.  Star Movement in an Uncorrected Flat Field 

 

Figure 2.  Star Movement after a Meridian Flip 

Flat fields should ideally be created before or after each observing session, and certainly when 

there is any change in the imaging chain. 
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The following are common techniques for generating flat fields from which a master flat can 

then be created: 

1. Twilight flats – flats are taken at dawn and dusk. Because of the speed that sky lighting 

conditions change, it is often cumbersome to take a good set of flats, especially if this has 

to be done for multiple filters. In some cases the flats may show stars if the exposure time 

is too long. Homemade diffusers using a white T-shirt have been a popular way to 

mitigate this problem. 

2. Light boxes – homemade light boxes have been used by some amateur astronomers to 

create flats. However, using this technique to produce a uniform light field is sometimes 

challenging. 

3. Electroluminescence panels -  although at some cost, the technique has several 

advantages: it can create a relatively good uniform light field, its brightness can be 

changed to accommodate different filters, and flats may be taken at the observer’s 

convenience. 

4. Observatory flats – this technique used in permanent observatories consists of the 

telescope being pointed to a lit white panel on the wall of the observatory. The efficacy of 

this technique varies widely with the nature of the white panel, ambient lighting, etc. 

 

6.3.3. Creation of Master Files 

 

Image calibration eliminates the effects of the following underlying factors that affect the 

precision of the measurements: bias, dark current, and dust donuts and vignetting. The following 

are best practices for dealing with each of these factors: 

1. Bias files should be taken at some time before or after the observing session. These are 

then used to create a master bias file, ideally using median combine.  

2. Dark files should be taken at the end of the observing session. The reason for taking them 

at the end of the observing session is to make sure that they are taken at the same 

temperature as the science images. A master dark file is then created from them, again 

using median combine. 

3. Flat files should be taken either at the beginning or end of the observing session. Since 

flat files themselves have dark current and are at a different exposure time than the 

science images, they need to have dark current removed. Rather than creating a master 

dark specifically to make dark correction for the flats, another approach is to use the same 

master dark file created for the science images, but scale it to the exposure time of the flat 

files. Software such as AIJ, has such a scaling feature. Section 6.3.2 above describes the 

best practices for creating flat files. 

 

6.3.4. Updating FITS Header Information 

 

During the image calibration phase, some software packages such as AIJ allow the user to update 

the FITS headers in the science images with information such as the equivalent BJDTDB times of 
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the observation. If not included in the FITS header by the image capture software, other 

important information such as AIRMASS can be included as well. As will be seen later, 

AIRMASS is one of the more commonly used detrend parameters during the transit modeling 

process. 

 

6.4. Aperture and Differential Photometry Phase 

 

As was mentioned in Section 3, the exoplanet transit method is all about comparing the relative 

change in brightness between the target star and a set of suitable comparison stars. Before this 

comparison can be done, however, the brightness of each star needs to be adjusted for any 

photon counts due to the background sky that might be affecting each particular star. This is 

done using aperture photometry. Once this is done, the relative change in (adjusted) flux between 

the host star and the comparison stars can then be obtained. This process is called differential 

photometry. The best practices associated with aperture and differential photometry are 

described below. 

 

6.4.1. Aperture Photometry 

 

Aperture photometry involves defining both the “aperture” of a certain radius around a star, as 

well as an outer “annulus.” The idea of the annulus is to measure the sky background around the 

star. Figure 3 depicts an aperture of radius 9 and an annulus starting at 16 pixels from the 

centroid of the star and ending at pixel location 24. 

 

 

Figure 3.  Aperture and Annulus 

In order to compensate for background sky contribution, the ADU counts per pixel in the annulus 

are used to adjust the ADUs in the aperture. Some software such as AIJ also has the ability to 

detect and adjust for any faint stars that might happen to be in the annulus and therefore bias the 
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background sky counts. As will be described later, the radii settings initially set for the aperture 

and annulus may be changed after an exoplanet model fit is done to further optimize the fit. 

Section 7.5.1 describes how AIJ can be used to select the initial size of the aperture and annulus. 

 

6.4.2. Differential Photometry  

 

Differential photometry involves applying aperture photometry on the target star and multiple 

comparison stars and then comparing the relative differences in (adjusted) flux. The following are 

the best practices for selecting suitable comparison stars: 

1. Ideally, at least 8 comparison stars should be chosen whose magnitudes are as close as 

possible to that of the target star – i.e., no greater than 0.75 in magnitude (i.e., fainter) and 

no less than 0.44 in magnitude (i.e., brighter) than the target star. If this is not possible, 

then an ensemble of comparison stars should be selected such that the average of their 

aperture counts are close to that of the target star. 

2. The comparison stars should ideally be of similar stellar type to the target star in order to 

minimize the differences in atmospheric extinction. However, if the transit modeling 

software is able to “detrend” the effects of AIRMASS, such as is possible with AIJ, then 

choosing comparison stars of similar brightness to the target star is more important than 

choosing stars of similar stellar type. 

3. The comparison stars should not be inherently variable. This can later be determined by 

viewing the light curve of each comparison star as described in the next section, or by using 

information from the AAVSO’s Variable Star Plotter utility (AAVSO, 2017). 

 

The results of the differential photometry phase will be a Measurements file that has, as a 

minimum, for each image: the timestamp of the image, the change in flux or magnitude of the 

target star (relative to the comparison stars), and its associated errors.  Depending upon the 

differential photometry software, other valuable data could include the relative change in flux or 

magnitude of each comparison star (relative to all the other comparison stars), their associated 

errors, and changes in the X,Y pixel coordinates of the target and comparison stars. 

 

7. Using AstroImageJ 

 
The rest of this Guide describes the use of AIJ for the post-processing of science images and for 

conducting exoplanet model fitting. The use of AIJ assumes that the user has already installed 

AIJ and has read the AIJ User Guide, available at: 

http://www.astro.louisville.edu/software/astroimagej/. 

The user is encouraged to regularly check for an AIJ software update.  This is done by clicking 

on Help in the upper right corner of the main AIJ Toolbar (see Figure 4) and then selecting 

“Update AstroImageJ…”. 

http://www.astro.louisville.edu/software/astroimagej/
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Figure 4.  AIJ Toolbar 

Data from actual exoplanet transits will be used in the examples throughout the rest of this 

Guide. Both the calibration files and original images for the WASP-12b example can be found at 

http://astrodennis.com. 

 

7.1. Loading Images into AIJ 

 

A single image or a sequence of images can be loaded into AIJ. 

To open a single image, select File->Open from the AIJ Toolbar (Figure 4) and then select the 

desired file. The Image Display screen (see Figure 5) then appears. One example of useful 

information that can be obtained from any one of the science images are the contents of its FITS 

header.  This information can be obtained by selecting Edit->FITS header on the top of the 

Image Display screen.  Many of the operations on the Image Display Screen that are described 

below for a sequence of images can also be applied to a single image. 

 

Figure 5.  Image Display Screen 

http://astrodennis.com/
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A set of images can be loaded into what is called an AIJ “stack.” Each image in the stack is 

called a “slice.”  The stack is an active set of images that various AIJ functions can be applied to. 

From the AIJ Toolbar select File->Import->Image Sequence and then select ONE file in the 

subdirectory containing the calibrated science images (note: do not try to select a range of 

images; it is necessary only to select one of the files in the subdirectory).  A screen similar to the 

one in Figure 6 appears. 

 

 

Figure 6.  Sequence Options Screen 

If the computer running AIJ has sufficient memory to hold all images in the stack, then the “Use 

virtual stack” selection on the Sequence Options screen can be unchecked, thereby causing AIJ 

to run faster since the images can be directly accessed from memory.  If an out-of-memory 

message appears in this case, then more memory can be allocated to AIJ by performing the 

following: 

1. From the main AIJ Toolbar, go to Edit->Options->Memory and Threads… 

2. Change the Maximum memory value to a larger value. 

Next, with the boxes checked as in Figure 6, with the possible exception of the virtual stack 

selection, select OK. This creates an AIJ stack of the calibrated science images. The Image 

Display (Figure 5) then shows the first image in the stack. 

 

 

7.2. Calibrate Science Images 

 

The Data Processing (DP) function of AIJ can first be used to calibrate the science images taken 
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during the Imaging Phase. Note: Before proceeding with this section, it is strongly suggested that 

the reader review Section 6 (DP User Interface) of the AIJ User Guide. The DP function is 

initiated by clicking on the   icon from AIJ’s main Toolbar. Figure 7 is an example of one of 

the two screens that then appears. 

 

Figure 7.  CCD Data Processor Screen 

An example of the other screen that appears is depicted in Figure 8, which may initially be 

covering the CCD Data Processor Screen. 
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Figure 8.  DP Coordinate Converter Screen 

The purpose of the CCD Data Processor screen is to calibrate the science images using the bias, 

dark, and flat field files previously captured. There are several ways, however, in which the 

master bias, dark, and flat files used for calibration can be created. For example, the master files 

can be created in separate runs of the CCD Data Processor, and then one final run specifies the 

master files being used. In addition, the user may use other programs for accomplishing the 

calibration and may simply decide to use AIJ to just update the FITS headers of the calibrated 

files, which process is described below. In the example depicted in Figure 7 and described 

below, AIJ uses one run to accomplish everything: master files are first created from individual 

bias, dark and flat files, these master files are then used to calibrate the 336 science images, and, 

finally, the FITS headers of the resulting calibrated files are updated. In the example below, the 

original dark files and science images had an exposure time of 45 seconds and the flat field files 

had an exposure time of 3 seconds. 

 

7.2.1. Specifying Science Images and Calibration Files 

 

The first step in conducting image calibration is to specify where AIJ can find the science images 

and the calibration files. 
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Under the Science Image Processing section on the CCD Data Processor screen, the “Enable” 

and “Sort Num” boxes are checked and the directory is entered where the science images reside 

(this can also be done by clicking on the folder icon and selecting the appropriate subdirectory).  

Next, the appropriate file extension with the wildcard indicator “*” for the filename path is 

entered. If the filename path and extension for the science images have been properly entered, 

then the Totals count to the right should be correct. 

The above method should also be used for specifying the subdirectories and file extensions for 

the bias, dark and flat files.  For each of these sets of calibration files, a subdirectory and full 

filename (not just extension) should be entered for their respective to-be-created master files. For 

example, in Figure 7, a master dark called mdark.fits will be created in the same subdirectory 

where the individual darks are found. 

The Build and Enable checkboxes for each of the calibration types should also be checked, and 

the choice made for whether average (ave) or median (med) combine should be used to create the 

masters. If the darks are to be scaled and used as flat darks, then the “scale” and “deBias” boxes 

should be checked. 

 

There are variations to the above.  For example, to use already created masters, the “Build” 

boxes do not have to be checked. 

Note: It is important that the “Remove Outliers” option is NOT selected when differential 

photometry is being done and that the Polling Interval under the Control Panel is set to 0. Also, 

unless the “Enable” option for Filename Number Filtering or the  “Enable Linearity Correction” 

option are being used (see Section 6.3.2.1 and Section 6.3.2.5, respectively of the AIJ User 

Guide), then they should not be enabled. 

 

7.2.2. Updating FITS Header Information 

 

AIJ has two methods for obtaining some essential information such as AIRMASS, BJDTDB 

times, etc., which will be useful during the Photometry, Plotting, and Modeling Phase. The first 

method is to update the Measurements file that is created after differential photometry has been 

applied to the calibrated images. This method is described in Section 7.6 below. This method, 

however, does not update the FITS headers of the calibrated files, so each time a new differential 

photometry measurement is performed on the calibrated images, this update would have to take 

place again. It should be noted that some camera capture software will include AIRMASS in the 

FITS header, but most likely not BJDTDB. 

The second method, which occurs during the Calibration Phase, is to include this information 

directly in the FITS headers of the calibrated files. Thus, at the time the calibration files are 

being corrected with any bias, darks, and flats, their FITS headers are being updated as well. This 

is the preferred of the two methods, since multiple modeling runs can be made with different 

photometry settings, without having to update the Measurements file after each run with 

information such as AIRMASS and BJDTDB time. 
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To update the FITS headers during the calibration process, the user should select General under 

the FITS Header Updates section of the CCD Data Processor screen (see Figure 7). The DP 

Coordinate Converter Screen then appears (Figure 8), if it isn’t already open.  

To update the FITS headers,  AIJ needs the RA and DEC coordinates of the target, as well as the 

location where the observation was conducted. This information can be manually entered, or AIJ 

can automatically extract this data from the FITS headers if it was included there by the user’s 

image capture software. 

 

7.2.2.1. Entry of Target and Observation Location Information 

 

In the case of manual entry of the target’s coordinates and/or the observation location, the user 

would select “Coordinate Converter manual entry” under either or both the Target Coordinate 

Source box and the Observatory Location Source box. On the DP Coordinate Converter screen, 

the user would then enter the Lon (Longitude), Lat (Latitude), and Alt (Altitude) fields in the 

Geographic Location of Observatory section and/or enter the target’s RA and DEC fields in the 

J2000 Equatorial section. 

If RA and DEC coordinates are already part of the image’s FITS header, the user would select 

“FITS header target RA/DEC (2000)” under the Target Coordinate Source box. If the 

observation location is already part of the image’s FITS header, the user would select “FITS 

header longitude and latitude” under the Observatory Location Source box.  

 

7.2.2.2. Dynamical Time Updates 

 

No matter which method is used by AIJ to obtain the target’s coordinates and the observation 

location, the user should perform the following under  the Dynamical Time section of the DP 

Coordinate Converter Screen: 

1. Auto should be selected. 

2. The Update button should be clicked. 

These actions will allow AIJ to account for the appropriate number of additional leap seconds 

when it is doing its time conversions to BJDTDB . 

 

7.2.2.3. Other Required FITS Header Information 

 

Next, it is important that the raw science images have information in their FITS headers about 

the date/time of the start of the observation, as well as the exposure time. Sections 6.3.2.6.1 and 

6.3.2.6.2 of the AIJ User Guide describe the acceptable FITS header keywords that AIJ can use 

to obtain this information. 
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7.2.2.4. FITS Header Settings 

 

Once the above observatory and target information is filled in, and it is confirmed that the FITS 

headers contain acceptable date/time and exposure information, then the user would select the   

 icon on the CCD Data Processor screen.  The General FITS Header Settings screen then 

appears (Figure 9). 

 

Figure 9.  General FITS Header Settings Screen 

If the automatic entry method was used for the target coordinates, then the appropriate keywords 

in the image’s FITS header associated with this information should be included in the Target RA 

Keyword and Target DEC Keyword entries under the FITS Header Input Settings portion of the 

screen (see Figure 9). Common keyword pairs for this information are: RA_OBJ, DEC_OBJ and 

OBJCTRA, OBJCTDEC; however, the user should confirm which keyword pair is placed in the 

images’ FITS header by the user’s image capture software. 

Likewise, if the automatic entry method was used for the observation location, then the 

appropriate keywords in the image’s FITS header associated with this information should be 

included in the Observation Latitude Keyword and Observation Longitude Keyword entries. 

SITELAT and SITELONG are such keywords. NOTE: some image capture software, such as 

SkyX Pro, might put a positive number in the FITS header for longitude even though it is West 

longitude (West longitude is typically shown with a negative sign, unless it is expressed as 
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Elongitude – namely, total degrees from 0 longitude.). If West longitude is a positive number in 

the user’s FITS header, then the user should check the “negate” box to indicate to AIJ that the 

number found in the FITS header should really have a negative sign associated with it. 

The FITS Header Output Settings portion of the screen indicates which items will be added to 

the calibrated images (indicated by those that have “enabled” checked).  Note: it is suggested that 

all the keywords stay as “enabled.” 

 

7.2.2.5. WCS Information 

 

Finally, although not done in this example, the World Coordinate System (WCS) coordinates for 

each star in each image can be obtained by selecting the Plate Solve option on the CCD Data 

Processor Screen.  It should be noted, however, that this process could take a long time and in 

many cases is not necessary (see Section 7.4 below for obtaining WCS coordinates for selected 

images). 

 

7.2.3. Begin the Calibration Process 

 

Using the above as an example, when the START button is selected, the DP routine will 

automatically perform the following steps: 

1. Create a Master Bias (mbias.fits) from the 16 bias files. 

 

2. Create a Master Dark (mdark.fits) from the 16 dark files. Correct this Master Dark with 

the Master Bias. Thus, the Master Dark will have bias removed from it. 

 

3. Create a Master Flat (mflat.fits) using the 16 flat files in the following manner: 

a. first calculate a scaling factor that represents the ratio of the exposure times of the 

flat fields to the exposure time of the original dark files (in this example, the 

scaling factor would be 0.0667=3 sec/45 sec); 

b. perform bias correction using the Master Bias; 

c. perform dark correction using the Master Dark, scaled with the scaling factor; 

d. remove gradients; 

e. normalize the calibrated flats. 

 

4. The FITS headers of the calibrated files are updated. 

 

5. Calibrate each science image using the resulting Master Bias, Master Dark, and Master 

Flat. An Image Display is seen for each image as it is being calibrated. 

 

6. The calibrated science images are stored in a calibration subdirectory under the 

subdirectory that held the Science Images. In this example, the subdirectory will be called 
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pipelineout and its files will have a suffix of _out. 

 

7.2.4. Real-time Operation 

 

In addition to conducting image calibration after the observation, AIJ is also capable of operating 

“in real-time” if the Polling Interval is set to a non-zero value.  In this case, at the specified 

Polling Interval rate, AIJ will automatically check the science image directory for newly added 

files that match the file pattern matching and number filtering criteria specified on the CCD Data 

Processor screen. AIJ will then calibrate them, will optionally conduct differential photometry on 

them, and will optionally update the light curve (see the checkboxes under Post Processing on 

the CCD Data Processor screen for selecting these options). 

 

7.2.5. Additional Options 

 

Section 6 of the AIJ User Guide provides other options available for the CCD Data Processor 

screen. 

 

7.3. Loading Calibration Images 

 

After calibration, the images in the calibration subdirectory can be loaded into AIJ (see Section 

7.1 on how to load a set of images). 

In order to make sure that the field-of-view (FOV) indicators are correct for both the vertical and 

horizontal axes on the Image Display Screen for the calibration images, the correct X and Y 

pixel scales should be set. Pixel scales will have been set correctly if WCS coordinates were 

already found by using either the Plate Solve option on the CCD DP Processor screen (see 

Section 7.2.2.5) or one of the WCS->Plate solve options on the Image Display screen (see 

Section 7.4). Alternatively, correct pixel scales can be manually entered by selecting, at the top 

of the Image Display Screen, “WCS->Set pixel scale for images without WCS…”, and then 

entering the correct X and Y pixel scale values. 

The slider below the image can then be used to move through all the images in order to find ones 

that should be eliminated due to excessive cloud cover, poor guiding, or other anomalies. If 

images show increasing degrees of misalignment, see Section 7.5.3 how to correct for this. Poor 

images can be deleted by bringing up that particular image on the Image Display and then simply 

selecting the “delete currently displayed slice”  icon in the upper left of the Image Display. 

Alternatively, Edit->Stack->Delete can be selected from the menu bar on the Image Display.  It 

is advisable, however, to move such poor images from the calibration subdirectory where they 

reside to a separate “Quarantined Images” subdirectory.  This is so that if the differential 

photometry needs to be redone on files in the calibration subdirectory, then the user does not 

have to go through this image elimination process again. 
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7.4. Plate Solving Using AIJ 

 

Plate solving means associating stars in an image with their RA and DEC coordinates. 

Optionally, this information can also be permanently stored back into the image’s FITS header 

for possible later use. The information stored in the FITS header uses WCS information; this 

information allows subsequent runs to identify the RA and DEC coordinates of selected stars. 

The following are examples where it might be desirable to use one or more plate solved images: 

1. it may be useful to plate solve an image to locate the exact location of the target star in a 

crowded field of stars; 

2. if images are misaligned throughout the observing session, or a meridian flip has 

occurred, it may be useful to track the location of particular stars from one image to the 

next during the differential photometry process using their RA and DEC coordinates. 

Images that contain WCS information from other software can be used by AIJ, or AIJ itself can 

be used to plate solve one or more images in the image stack. This is done by selecting from the 

Image Display menu “WCS->Plate solve using Astrometry.net (with options)…” A screen 

similar to the one in Figure 10 then appears. 

 

Figure 10.  Astrometry Settings Screen 

AIJ can then use either the online astrometry.net facility for plate solving, or Windows users can 

use a local version that does not require an online connection. The following describes each of 

these alternatives. 

 

7.4.1. Astrometry.net Alternatives 

 

Alternative 1: Plate Solving Using the Online Version of Astrometry.net 
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For this alternative, an Astrometry.net key is first obtained. This is done by logging in at 

http://nova.astrometry.net/signin/?next=/api_help using, for example, the user’s Yahoo login 

information. The key can then be found under My Profile. It is called “my API key.” This key is 

then entered into the User Key field on AIJ’s Astrometry Settings Screen. 

Alternative 2: Plate Solving Using a Local Version of Astrometry.net 

Windows users can use can an alternative to the online version of astrometry.net to perform plate 

solving, In this case, AIJ uses a local  astrometry.net server. The server, developed by Andy 

Galasso, is called ansvr.  It can be installed by going to http://adgsoftware.com/ansvr/ and 

following the installation instructions there. Once installed, plate solving can be done locally by 

enabling “Use Custom Server” on the Astrometry Settings Screen (see Figure 10). 

7.4.2. Astrometry Information 

 

After the appropriate alternative for invoking astrometry.net is chosen, the following other 

entries should be made on the Astrometry Settings Screen: 

1. “AutoSave” should be checked if the user wishes that the FITS headers of the original 

image files are to permanently updated with the appropriate WCS information. 

2. The slice number(s) of the image(s) in the stack to be plate solved should be entered in 

the Start Slice and End Slice fields. 

3. The radii of the aperture and annulus settings that will be used during the differential 

photometry process (see Section 7.5.1 below) should be entered in the Radius, Sky Inner, 

and Sky Outer fields. 

4. The correct Pixel Scale value for the user’s imaging system should be then be entered, as 

well as some tolerance for its precision. 

5. Next, the approximate RA and DEC coordinates of the center of the image, as well as 

some search radius for suitable stars that can be used during the plate solve process. The 

user might try first starting with the width of the image, and then reduce it from there. 

6. All other values and checkboxes can be set as they appear in Figure 10.  When START is 

selected, the plate solving process will begin 

 

7.5. Conduct Differential Photometry 

 

With known candidate comp stars, differential photometry can take place on the images in the 

stack. See Section 6.4.2 for guidelines on selecting suitable comp stars. 

 

7.5.1. Select Appropriate Aperture and Annulus Settings 

 

The first step is to define the appropriate radius of the aperture and the radii of the inner and 

outer rings of the annulus. This is done as follows: 

http://nova.astrometry.net/signin/?next=/api_help
http://adgsoftware.com/ansvr/
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The   icon on the Image Display screen is selected causing the Aperture Photometry Settings 

screen to be displayed (Figure 11) . 

 

Figure 11.  Aperture Photometry Settings Screen 

The initial radii of the aperture and annulus can then be appropriately set using any one of three 

methods. 

Method 1.  The initial radii settings can be determined using the Seeing Profile screen associated 

with the target star (see Figure 12). This screen appears when the target star is ALT-clicked. The 

radius shown for the Source and the beginning and ending values for the Background can then be 

used for the initial aperture radius, and the inner and outer annulus radii settings, respectively. 
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Figure 12.  Seeing Profile Screen 

Method 2. The initial radii can also be determined according to the following guidelines (note 

that AIJ’s automatic selection of recommended values via Method 1 is consistent with these 

guidelines): 

1. The initial radius of the aperture (r1) should be at least 2 times the number of FWHM 

pixels. 

2. The initial radius of the inner annulus (r2) should be chosen such that it and the radius of 

the outer annulus create an annulus region that excludes any other stars that happen to be 

close to the target star. 

3. The initial value of the outer annulus radius should equal the SQRT(4*r1
2+r2

2).  This 

formula should produce an annulus that contains 4 times the number of pixels that are in 

the aperture. 
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Method 3.  Finally, the initial aperture/annulus settings can be determined by using the ones that 

maximize the SNR of the target star. AIJ can be used to determine the SNR of the target star in 

the following manner: 

1. Click on the Set aperture settings icon   on the Image Display screen. Set the aperture 

and annulus radii to some initial settings and then click on OK.  

2. Click on the Single Aperture Photometry icon  on AIJ’s Toolbar. Place the resulting 

concentric circles onto the target star in the Image Display and left click. 

 

3. This will produce a new Measurements table that should include the SNR measurement 

under the column Source_SNR. Each subsequent change in aperture settings and Single 

Aperture Photometry selections will add a new row to this table. 

Note: each such newly created (extraneous) row in the Measurements table should then be 

deleted before the Measurements table is used for transit modeling. This is done by highlighting 

the row(s) to be deleted in the Measurements table and then selecting Edit->Cut from the 

Measurements table menu bar. 

Of the above three methods, Method 1 is the preferred one for obtaining an initial set of aperture 

and annulus settings. 

It should be noted that the final settings of the aperture and annulus radii should be those that 

minimize the Root Mean Square (RMS) of the residuals of the light curve that is created during 

the transit model fit. RMS is a measure of how well the model “fits” to the observed data. This 

implies that multiple runs of the model fit, as described in Section 7.11 below, would need to be 

run with different values for the aperture and annulus radii settings. 

 

7.5.2. Prepare For and Begin the Differential Photometry 

 

In scanning through the images in the stack, it may appear that they are gradually offset from 

each other and therefore not all aligned. Sections 7.5.3 and 7.5.4 below show how to deal with 

varying degrees of misalignment, as well as a meridian flip. 

On the Aperture Photometry Settings Screen (Figure 11), the user should enter a comma-

separated list of keywords for any FITS header values that the user would like extracted and 

added to the Measurements table. In addition, the appropriate values for the CCD’s gain, readout 

noise and dark current should be entered.  Finally, the appropriate settings for Saturation and 

Linearity warnings should be set. All of the other checkboxes could be kept as shown in Figure 

11. The user would then select OK. 

Next, the    icon on the Image Display’s menu bar would be selected to bring up the Multi-

Aperture Measurements screen (see Figure 13). Values for the range of slices and aperture and 

annulus radii are automatically filled in. If all the images were plate solved, then “Use RA/Dec to 

locate aperture positions” could be checked. All other checkboxes could be kept as in Figure 13. 
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Figure 13.  Multi-Aperture Measurements Screen 

The user should also have enabled the following four icons on the Image Display menu bar: 

 

These selections allow for the aperture/annulus rings to be displayed with target and comp star 

names and associated intensity counts, and helps to automatically position the aperture/annulus 

rings on each star’s centroid. 

The user would then select Place Apertures and then place and click the floating concentric 

circles on the target star and the comp stars. The Image Display would then appear similar to that 

in Figure 14. 
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Figure 14.  Sample Image with Aperture/Annulus Applied to 

Target and Comp Stars 

Next, by hitting Enter on the keyboard, the differential photometry process will begin. A 

Measurements table will be constructed with each row representing the measurements for each 

slice in the stack. The labels in the Measurements table header identify the type of data in the 

label’s column. Some of these labels correspond to common FITS header identifiers, and others 

are the Keywords specified in the Aperture Photometry Settings display (see Figure 11). 

At this point, the Measurements table should be saved to a subdirectory like something called 

AIJ Analysis. This is accomplished by selecting File->Save As on the Measurements table menu 

and selecting the AIJ Analysis subdirectory. The Measurements table is stored by AIJ with an 

extension of .xls and is a tab delimited file. 

It should be noted that if the differential photometry needs to be redone on images currently in 

the stack, the following steps should be done: 
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1. Clear the existing aperture/annulus rings by selecting the “clear apertures and annotations 

from overlay “ icon   on the Image Display. 

2. On the Multi-Aperture Measurements Screen (Figure 13), make sure that the checkbox 

next to “Use previous  X apertures” is unchecked. 

 

7.5.3. Dealing with Misaligned Images 

 

A shift in image orientation and therefore misalignment could be the case if guiding is poor. If 

the image shift is not too severe, AIJ’s Align Stack function could be used to align the images in 

the active stack.  This can be accomplished by selecting the “align stack using apertures” icon 

on the Image Display screen and entering a fairly large aperture setting, with correspondingly 

larger annulus settings. Images in the stack are aligned using this feature and the resulting 

aligned images are stored in a new subdirectory labelled “aligned.” Images in this subdirectory 

should then be the ones used during the differential photometry phase. The user should not forget 

to change back the aperture and annulus settings to ones that are appropriate for the differential 

photometry phase. 

In the case of image rotation due to severe image shift, which AIJ’s Align function cannot 

correct, then the following can be done: 

1. First, plate solve each image (see Section 7.4). 

2. After plate solving has been completed, the user can then perform the differential 

photometry as before, except that on the Multi-Aperture Measurements screen (Figure 

13), the box labelled “Use RA/Dec to locate aperture positions” should be checked. In 

addition, the First and Last slice should indicate the entire range of slices. 

3. When the Place Apertures button is selected on this screen, the user would then place the 

aperture/annulus rings on the target and comp stars and, as before, press Enter on the 

keyboard. All the images in the stack are now analyzed. 

 

7.5.4. Dealing with a Meridian Flip 

 

If a meridian flip had occurred during the imaging session, then the images would be rotated 

180° from the orientation shown in Figure 5.  Thus, for the images taken after the flip, the 

aperture/annulus rings would not fall on the correct locations for the target and comp stars. Note: 

even if the CCD camera itself was rotated immediately prior to the beginning of imaging after 

the meridian flip, it is unlikely that the target and comp stars would land within the same 

aperture/annulus rings. 

To conduct differential photometry with AIJ in the case of a meridian flip, the following method 

can be used (note: if there are misaligned images during the pre-flip period or during the post-flip 

period, then the method described in Section 7.5.3 should be used): 
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1. First, plate solve just the first image in the entire sequence.  This is accomplished by 

entering “1” in both the Start Slice and End Slice fields of the Astrometry Settings screen. 

This will cause just the first image in the stack to be plate solved. 

2. Next, the slice number for the image in the stack immediately following the meridian flip 

should be entered in these two fields and it should be plate solved. 

3. On the Multi-Aperture Measurements screen (see Figure 13), the checkbox labelled “Use 

RA/Dec to locate aperture positions” should then be CHECKED and the checkbox 

labelled “Halt processing on WCS or centroid error” should be UNCHECKED. 

When the differential photometry is now conducted, AIJ will proceed through the pre-flip 

images, using the coordinates in the first slice for placement of the aperture and annulus on 

subsequent pre-flip images, and then using the coordinates of the first slice after the flip for the 

remaining images in the stack. 

 

7.6. Prepare for Model Fit 

 

In preparation for a model fit, the Multi-Plot Main   icon on the AIJ toolbar should be 

selected. When this is done, the following four screens pop-up: 

Multi-plot Main 

Multi-plot Reference Star Settings 

Multi-plot Y-data 

Data Set 2 Fit Settings. 

An AIJ file with an extension of .plotcfg contains the information used to create these screens. A 

template.plotcfg file that the user can start with can be found at http://astrodennis.com.   The user 

can open a .plotcfg file by going to the upper left corner of the Multi-plot Main screen and 

selecting “File->Open plot configuration from file…”  Likewise, the current instance of the 

above screens can be stored by selecting “File->Save plot configuration…” 

The first step is to update correct values in the AIRMASS, HJD_UTC, and BJD_TDB column 

entries in the Measurements table if this was not done during the Calibration phase (see Section 

7.2 above). This is accomplished as follows: 

From the Multi-plot Main menu, select “Table->Add new astronomical data columns to table.” 

The following two screens then appear: “MP Coordinate Converter” and “Add astronomical data 

to table” (see Figure 15). 

http://astrodennis.com/
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Figure 15.  Screens for Correcting AIRMASS and Time Standard Values 

On the MP Coordinate Converter screen, verify that the values are correct for Geographic 

Location of Observatory and the J2000 Equatorial Coordinates for the target star. Also, select 

Update and Auto under the Dynamical Time section.  On the “Add astronomical data to table” 

screen, verify that the boxes are checked as shown in the right-most screen in Figure 15, and then 

select Update Table. Press OK if the “Over-write existing data?” dialog box appears.  The 

AIRMASS, HJD_UTC, and BJD_TDB columns in the Measurements table will then be updated. 

 

7.7. Conduct Model Fit 

 

On the Multi-plot Main screen, fill in the Title and Subtitle entries (see Figure 16). Under the Fit 

and Normalize Region Selection box, entries are made for the Left and Right boxes that 

represent the predicted transit start and end times, respectively. At the upper right of the Multi-

plot Main screen, the copy icon  is then selected. This positions the Predicted Ingress and 

Predicted Egress times on the V.markers at the appropriate places on the Plot of Measurements 

screen. The V.markers should remain untouched thereafter in order to show what the initial 

predictions were.  However, the Fit and Normalize markers should later be positioned to the 

apparent ingress and egress points as shown on the Plot of Measurements screen (Figure 22). 

Furthermore, the Left Trim and Right Trim fields can be used to eliminate some amount of pre-

ingress and post-egress data from the model. This might be done, for example, if there were 

systematics during the beginning or end of the observing session.  The values in the Meridian 

Flip, Fit and Normalize Region, and V.Marker boxes are only the decimal part of the associated 

time (for example, 0.83508 would be entered if the time in question was 2457395.83508). If, 

however, the begin time is, say, 2457395.83508 and the end time “rolls over” into, say, 
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2457396.00175, then the begin decimal part should be 0.83508, but the end decimal part should 

be 1.00175. 

Next, under the X-Axis Scaling box, check the Auto X-range button and click on the  icon. 

The X-min and X-max boxes will automatically be filled in with the minimum and maximum X 

values (BJD_TDB times in this example) that are in the Measurements table.  Note: for this to 

work, at least one row on the Multi-plot Y screen (see Figure 17) should have its checkbox 

checked in the Plot column. Alternatively the user can click on the Custom X-range box and fill 

in different X-min and X-max values. The Y-Axis Scaling box can be used now or later to allow 

the various plots to be sized so they all appear on the Plot of Measurements screen (see Figure 

22). The Plot Size entries are used to size the Plot of Measurements screen on the user’s 

computer monitor. 

 

Figure 16.  Multi-plot Main Screen 

If a meridian flip has occurred, or if there is a break in the image session and the stars have 

moved to a different part of the CCD detector, then the Meridian Flip box on the Multi-plot Main 

screen is used to place a line in the middle of the gap where this discontinuity of data has 

occurred. The Show box should be checked and an entry made in the Flip Time box so that the 

Meridian Flip line is placed on the Plot of Measurements screen at the appropriate place. 
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7.8. Light Curve Plot 

 

Before a visual plot of selected data sets can be obtained via the Plot of Measurements screen 

(Figure 22), the Multi-plot Y Data screen (Figure 17) needs to be setup.  This is the main screen 

that determines where and how different data sets are plotted 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 17.  Multi-plot Y Data Screen 

The following are the key parameters and selections for the Multi-plot Y screen: 

The Plot column is used to select if a particular data set is to be plotted. 

The Y-data column is used to select which data sets (namely which columns in the 

Measurements table) are associated with which row on the screen. 

The Bin Size column indicates the number of points in the associated data set that are 

combined (binned) into one point. Typically, only the relative flux associated with the 

comp stars (i.e., rel_flux_Ci) is binned. Note that binning is for display purposes only and 

does not change the underlying Measurements table data. 
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The Fit Mode column is used to select the type of fit that should be applied to the 

respective data set, as well as the span of data (indicated by the green area) that will be 

included in the fit. Thus, as seen in Figure 22, the raw data points of the relative change 

in flux of T1 are plotted with no fit, while the second plot is a fit of this same data using 

an assumed transit model.  And finally, the relative flux changes of three comp stars are 

fit with a straight-line model (as will be seen later, one of the original comp stars, C5, 

was deselected after it was found to have significant residual errors).  The reason for the 

latter three plots being linear is because it is assumed that there should be no relative 

changes in the comp star brightness throughout the imaging session, unlike the relative 

flux of T1 where it is assumed that it will reflect a dip in brightness due to the exoplanet’s 

transit. 

The Trend Select column serves two purposes. First, it reflects the detrend parameters 

that are being applied to the associated Fit Mode, which themselves will be selected on 

the Data Set 2 Fit Settings Screen (Figure 18). Active detrend parameters are indicated by 

green. Second, selecting a particular detrend parameter will reflect its Trend Coefficient 

and the associated type of detrend data (e.g., AIRMASS). 

The Norm/Mag Ref column indicates the range of data used to normalize the respective 

data set. In the example in Figure 17, the relative flux of T1 is normalized based on the 

out-of-transit data – i.e., data to the left of the begin-of-transit (ingress point) and to the 

right of the end-of-transit (egress point). These later two points are set by the values in 

the Fit and Normalized Region Selection boxes on the Multi-plot Main Screen (Figure 

16). 

When checked, the Page Rel column indicates that the Scale and Shift columns should be 

interpreted as the percentage of the Y-range.  Unchecked means that the Scale and Shift 

values are absolute numbers applied to the Y-range. The Scale and Shift values, along 

with the Y-min and Y-max values on the Multi-plot Main screen, are used to properly 

position the various plots on the Plots of Measurements screen. It should be noted that the 

raw data set representing the relative flux of T1 (namely the first row in Figure 17) 

should always have a Scale value = 1. This is because this data may be used by other 

global fit programs and should not be scaled. 

 

7.9. Data Set Fittings Screen 

 

The Data Set 2 Fittings Screen (Figure 18) is automatically opened whenever there is a Transit 

Fit selected for a data set (in this case Data Set 2) under Fit Mode on the Multi-plot Y Data 

screen (Figure 17). The following user inputs on the Data Set 2 Fittings Set Screen are made that 

affect the resulting light curve: 

Period – enter the orbital period, if it is available, from http://exoplanets.org/; for 

example, in the case of WASP-12b, it is 1.09142245 days. 

http://exoplanets.org/
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Host Star Parameters – enter the spectral type (Sp.T) entry of the host star; this is strictly 

to estimate the radius R* of the host star, which itself is used simply to calculate the 

radius of the exoplanet. If the user has knowledge of R* (for example, from 

http://exoplanets.org/ ) then this value may be entered in the R*(Rsun) box. In this example 

for WASP-12, R*=1.630. 

Quad LD U1 and Quad LD U2 – these are the quadratic limb darkening coefficients 

associated with the host star and the particular filter being used. These values can be 

found by using the limb darkening coefficient calculator at 

http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml.  In the example here, 

the coefficients used for WASP-12b are 0.39056081 and 0.3026992, respectively. Note 

that these are placed in the Prior Center Column and locked. 

The AIRMASS Prior Center value should be set to 0.0 in most cases. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18.  Data Set 2 Fit Settings Screen 

The Y-min and Y-max values on the Multi-plot Main screen can be adjusted to display desired 

portions of the Measurements table on the plot, although as previously mentioned, it is best to 

select Auto-X-range under X-Axis Scaling on the Multi-plot Main screen to display the entire 

range of X-values. 

http://exoplanets.org/
http://astroutils.astronomy.ohio-state.edu/exofast/limbdark.shtml
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It is possible to see how the fit is improved by applying any number of Detrend Parameters. The 

most common is AIRMASS. Other Detrend Parameters can also be selected. If a meridian flip or 

a break in data collection has occurred where stars have moved on the CCD detector, then 

Meridian_Flip can also be selected (note that if this is done, the Flip Time selection and value 

must be made on the Multi-plot Main screen). Other Detrend Parameters could also be selected 

to see their effect(s) on the model fit. A good rule of thumb for whether a Detrend Parameter is 

effective is to view the Bayesian Information Criterion (BIC) value. If it reduces by more than 

2.0 when a Detrend Parameter is selected, then that Detrend Parameter should be selected. If it 

decreases by less than 2.0 or increases, then the Detrend Parameter is not that relevant. 

Plot Settings on the Data Set 2 Fit Setting Screen are used to define if and how the transit model 

and residuals are displayed. In addition, a Shift value is used to move the residual plot up or 

down on the Plot of Measurements screen. 

Finally, the Multi-plot Reference Star Settings screen (Figure 19) is used to deselect or select 

which comp stars the user would like to include in the model fit.  This is useful if it is determined 

after viewing a particular comp star’s relative flux in the Plot of Measurements screen (Figure 

22) that its data points do not follow a linear fit – i.e., an indication that it is most likely a 

variable star. In the example here, it was determined that comp star C5 had a large number of 

residual errors. Thus, it was deselected from the ensemble of comp stars to be used (see Figure 

20). When this deselection took place, comp star C5’s identifier was changed to T5 both on the 

screen depicted in Figure 20, as well as on the Image Display (see Figure 21). Its Plot selection 

box in Figure 17 was then unchecked so its plot no longer appeared in Figure 22. 

 

 

 

Figure 19.  Multi-plot Reference Star Settings Screen 
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Figure 20.  Multi-plot Reference Star Settings Screen after C5 was Deselected 

 

 

Figure 21.  Updated Images Display Showing C5 Changed to T5 

Note that C5’s data is now not included in the model fit, but its data is still maintained in the 

Measurements table. 
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The settings in Figure 16, Figure 17, Figure 18, and Figure 20 produced the light curve and other 

plots shown in Figure 22.  

Figure 23 is an example of an exoplanet fit based on data collected by amateur astronomer Paul 

Benni for exoplanet Wasp-76b. It shows how a Meridian_Flip detrend parameter was used to 

take care of an offset in data points caused by the target and comp stars landing on a different 

part of the CCD detector after the meridian flip occurred. 

 

Figure 22.  Plot of Measurements Screen 
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Figure 23.  Example Using Meridian_Flip Detrend Parameter 

 

7.10. Saving Model Data 

 

Since all of the previous model fitting and detrending does not change the Measurements table, 

the user is advised to save the current status of these and other fitting parameters by selecting 

File->Save all or File=>Save all (with options) in the upper left of the Multi-plot Main screen. 

 

7.11. Optimizing Model Fit 

 

With the various inputs that the exoplanet observer can change that might affect the model fit to 

a given set of data, several questions arise: 
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1. What input variables should be changed? 

2. In what order should they be changed? 

3. When is best model fit achieved? 

In order to answer these questions, the following guidelines are provided. These are intended for 

optimizing full transits only, and not partial transits, after an initial model fit: 

1. Initially select AIRMASS as the only detrending parameter. If a meridian flip was done, 

then Meridian_Flip should be maintained as a detrend parameter throughout the 

remaining steps below. 

 

2. Determine the effects on RMS of various comparison stars being removed (as seen 

earlier, AIJ allows the user to easily “deselect” a comparison star, in which case all of the 

computations associated with that star are redone). If the RMS decreases when a 

particular comparison star is deselected, then leave it out. It is sometimes the case that the 

relative flux of such stars also will show an amount of scatter greater than the target star 

and the other comparison stars. 

 

3. With the above selection of comparison stars and AIRMASS remaining as the only 

detrend parameter (with maybe the addition of Meridian_Flip), redo the differential 

photometry and model fits with smaller and larger aperture and annulus radii. Determine 

the effects on RMS for each new radii combination. Choose the combination that results 

in the lowest RMS. 

 

4. Repeat Step 2 on this new set of radii to achieve the best RMS. In addition to the 

resulting RMS value, record the BIC value that goes along with the best RMS. 

 

5. Determine the effects of different detrending parameters. First, remove AIRMASS 

detrending and see if BIC increases by 2 or more. If it does, keep AIRMASS detrending; 

if it does not, do not include AIRMASS. Next, add the following detrending parameters 

one at a time and observe changes in the BIC value: 

a. Width_T1, 

b. Sky/Pixel_T1, 

c. X(FITS)_T1, 

d. Y(FITS)_T1, 

e. tot_C_cnts, 

f. time (e.g., BJD_TDB), 

g. CCD-TEMP. 

Of those detrend parameters that result in at least a reduction of two (2) in the BIC value, 

choose the 3-4 parameters that cause the greatest reduction in this value. 

 

6. Using the resulting set of detrend parameters, repeat again Step 2 to see the effects on 

RMS from removing one or more comparison stars. 
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It should be noted that completing all of the above steps is optional.  However, if the results of 

the model fit are being supplied to a science team and these steps are not conducted by the 

observer, then the observer’s original calibrated images may have to be transferred to the science 

team for them to conduct a more detailed analysis. 

 

7.12. Input to External Programs 

 

For certain exoplanet research campaigns, the exoplanet observer may be asked to submit certain 

data for use by external programs. The example below shows how a file can be created for a 

global fit program that requires the following for each data point: its BJD_TDB time, the 

normalized relative flux of the target star for that data point, the error of the normalized relative 

flux of the target star, and values for any detrend parameters used in the AIJ model fit. 

Creating such a file is accomplished as follows: 

Click on the New Col down arrow for the data set representing the normalized relative 

flux of the target star (in the example used throughout here, this would be the first New 

Col down arrow in Figure 17).  A pop-screen then appears and entries would be made as 

shown in Figure 24. 

 

Figure 24.  Screen to Add New Columns to the Measurements Table 

When OK is selected, three new columns are added to the Measurements table. These 

columns add for each image the normalized relative flux of the target star and the error of 

the normalized relative flux of the target star, in addition to the BJD_TDB time again. 

Finally, to generate a file containing this information for an external global fit program, 

the “File->Save data subset to file…” selection is made from the Multi-plot Main screen. 

The Save Data Subset screen then appears (Figure 25) and entries are made as shown. In 

this case, the BJD_TDB value, the normalized relative flux of the target star, the error of 

the normalized relative flux of the target star, and the AIRMASS values are selected. 

AIRMASS is included because it is the detrend parameter used in the AIJ model fit. 
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Figure 25.  Save Data Subset Screen 

When OK is selected, a separate file is created that contains these values. Note: the values for 

Bin Size and Scale on the Multi-plot Y screen (see Figure 17) affect the calculation of the 

relative flux for T1 in this example. If any of these values have been changed, reset them to Bin 

Size=1 and Scale=1 before clicking on the New Col down arrow in the above example, unless 

such changes are intentional (e.g., if it is desired to bin data points). 

 

8. Summary 

 
As stated in the Introduction, this Guide was intended as a practical, step-by-step approach to 

image calibration, differential photometry, light curve plotting, and exoplanet transit modeling 

using AIJ. Users are encouraged to contact the author at the following email address for any 

suggested changes to areas that are unclear and could use further explanation: 

dennis@astrodennis.com. 
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Appendix A: 

Observation Worksheet 

Exoplanet: WASP-12b

Observer: Dennis Conti

Item Host Star/Exoplanet Information: (click here)

1 RA: 06:30:32.79

2 Dec: 29:40:20.4

3 Period (days): 1.0914

4 R*: 1.63

5 T eff : 6300

6 V mag: 11.7

Suggested range of comp stars: 11.26 to 12.45 mag

7 Link to Reference Paper (optional): https://arxiv.org/abs/1512.00464

8 Date of Observation (UT): 01/5-6/2016

 

BJD_TDB  

9 Predicted Ingress: 2457393.53948

10 Predicted Egress: 2457393.66431

Predicted midpoint: 2457393.60190

11 Model fit midpoint (Tc) in BJD_TDB: 2457393.60123

Approximate difference: 1.0 minutes

 Observing Location:

12      Latitude: 38:55:48.51 N

13      Longitude: 76:29:17.78 W

14      Altitude (m): 0

15 Aperture (mm): 280

16 Focal length (mm): 3010

17 Make/model of CCD Camera: SX694M

18 Gain (e-/ADU): 0.3

19 Readout noise (e-): 5.0

20 Dark current (e-/pixel/sec): 0.003

21 Point of where CCD goes non-linear (ADUs): 45,000

 X Y

22 No. of pixels (unbinned): 2750 2200

23 Pixel size (microns -unbinned): 4.54 4.54

24 Binning used for this observation: 2 2

25 Exposure time (secs): 45

26 Filter used: V

Limb darkening coefficients: (click here)

27     Quadratic LD u1: 0.39056081

28     Quadratic LD u2: 0.3026992

Image scale (arcsec/pixel): 0.62 0.62

 FOV (arcmin): 14.26 11.41

29 FWHM (arcseconds): 2.68

 FWHM (pixels): 4

Initial Settings:

30      FWHM pixel multiplier: 3

      Aperture radius: 13

31      Inner annulus radius: 14

      Outer annulus radius: 29

Final Settings:

32      Aperture radius: 13

33      Inner annulus radius: 14

34      Outer annulus radius: 29

# of Science Images:

35 Original #: 336 Final #: 336

36 Images not used:

 


